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Preface

As part of its effort to continuously improve and enhance the performance and capabilities of 
the EMC NetWorker VSS client for Microsoft Windows, EMC periodically releases new 
versions of the software. Therefore, some functions may not be supported by all revisions of the 
software currently in use. For the most up-to-date information on product features, refer to the 
product release notes.

If a product does not function properly or does not function as described in this document, 
please contact your EMC representative.

Audience This guide is part of the EMC NetWorker VSS Client for Microsoft Windows 2003 
documentation set. It is intended for use by system administrators, during 
installation and setup of the product. 

Readers should be familiar with the following topics:

◆ Microsoft Volume Shadow Copy Service (VSS) technology

◆ Storage subsystems, such as EMC CLARiiON or Symmetrix, if used

Organization This guide is organized as follows:

Chapter 1, ”Introduction,” provides the installation roadmap and checklist for the 
NetWorker VSS Client installation.

Chapter 2, ”Installing NetWorker VSS Client,” provides the information you need to 
install the NetWorker VSS Client successfully.

Chapter 3, ”Enabling, Registering, and Authorizing the Software,” provides 
information on how to enable the NetWorker VSS Client software for the purpose of 
evaluating and licensing the software for permanent use.

Chapter 4, ”Configuration Tasks,” contains the information you need to carry out 
configurations after installing the NetWorker VSS Client.

Related
documentation

Related documents include:

◆ EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, 
Administration Guide

◆ EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, 
Release Notes

◆ EMC NetWorker, Release 7.3.2, Multiplatform Version, Administration Guide 

◆ EMC NetWorker, Release 7.3.2, Multiplatform Version, Installation Guide

◆ EMC NetWorker, Release 7.3.2, Multiplatform Version, Release Notes
EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, Installation Guide 5



Preface
◆ EMC Software Compatibility Guide

◆ EMC NetWorker License Manager Installation Guide

◆ EMC Solutions Enabler Symmetrix CLI, Version 6.3, Quick Reference

Conventions used in
this document

EMC uses the following conventions for special notices.

Note: A note presents information that is important, but not hazard-related.

CAUTION

A caution contains information essential to avoid data loss or damage to the system 
or equipment. 

Typographical conventions
EMC uses the following type style conventions in this document:

Normal Used in running (nonprocedural) text for:
• Names of interface elements (such as names of windows, dialog boxes, buttons, 

fields, and menus)
• Names of resources, attributes, pools, Boolean expressions, buttons, DQL 

statements, keywords, clauses, environment variables, filenames, functions, 
utilities

• URLs, pathnames, filenames, directory names, computer names, links, groups, 
service keys, file systems, notifications

Bold: Used in running (nonprocedural) text for:
• Names of commands, daemons, options, programs, processes, services, 

applications, utilities, kernels, notifications, system call, man pages

Used in procedures for:
• Names of interface elements (such as names of windows, dialog boxes, buttons, 

fields, and menus)
• What user specifically selects, clicks, presses, or types

Italic: Used in all text (including procedures) for:
• Full titles of publications referenced in text
• Emphasis (for example a new term)
• Variables

Courier: Used for:
• System output, such as an error message or script 
• URLs, complete paths, filenames, prompts, and syntax when shown outside of 

running text 

Courier bold: Used for:
• Specific user input (such as commands) 

Courier italic: Used in procedures for:
• Variables on command line
• User input variables 

< > Angle brackets enclose parameter or variable values supplied by the user

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections - the bar means “or”

{ } Braces indicate content that you must specify (that is, x or y or z)

... Ellipses indicate nonessential information omitted from the example
EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, Installation Guide6
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Where to get help EMC support, product, and licensing information can be obtained as follows.

Product information — For documentation, release notes, software updates, or for 
information about EMC products, licensing, and service, go to the EMC Powerlink 
website (registration required) at:

http://Powerlink.EMC.com

Technical support — For technical support, go to EMC Customer Service on 
Powerlink. To open a service request through Powerlink, you must have a valid 
support agreement. Please contact your EMC sales representative for details about 
obtaining a valid support agreement or to answer any questions about your account.

Your comments Comments and suggestions about our product documentation are always welcome. 

To provide feedback:

1. Go to:

http://Powerlink.EMC.com

2. Click the Feedback link.
EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, Installation Guide 7
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Invisible Body Tag     

The EMC NetWorker VSS Client for Microsoft Windows requires special installation 
considerations. To help you understand the environment in which the NetWorker 
Client can be set up, this chapter provides information on the basic configurations in 
which the NetWorker VSS Client is supported. This chapter also provides the 
installation roadmap and checklist that you must review before the installing the 
software and configuring it after installation.

The EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, 
Administration Guide contains detailed information on how to use the software.

This chapter includes the following sections:

◆ Supported configurations ............................................................................................. 10
◆ Installation roadmap...................................................................................................... 13
◆ Installation checklist ...................................................................................................... 13
◆ Installation requirements .............................................................................................. 14
◆ Installation directories ................................................................................................... 16

Introduction
Introduction 9



Introduction
Supported configurations
An EMC® NetWorker® VSS Client can be set up in a LAN-based or LAN-free 
environment. 

Simple LAN-based configuration
Figure 1 on page 10 shows a simple LAN-based configuration with a storage area 
network. The application server that is being protected has the NetWorker VSS Client 
installed.

The data moves as follows:

1. The NetWorker server, which must be version 7.3.2 or later, initiates the process 
by contacting the application server where the NetWorker VSS Client software is 
installed.

2. The application server with the NetWorker VSS Client software creates a 
snapshot of the data on the storage volume.

Note: In the figures, snapshots are represented by S1 through S5.

The application server with the NetWorker VSS Client software uses a snapshot in 
primary storage to transfer the data over the LAN and into traditional storage such as 
a file type disk, advanced file type disk, or tape.

Figure 1 Simple LAN-based configuration
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e.g., CLARiiON
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S4
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SAN
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LAN-based configuration with a proxy client
Figure 2 on page 11 shows a LAN-based configuration with a storage area network 
and a proxy client. Both the application server and the proxy client have the 
NetWorker VSS Client installed.

A proxy client is a host that acts as a remote data mover when snapshots are rolled 
over to traditional storage such as a file type disk, advanced file type disk, or tape. A 
proxy client frees resources on the application server by offloading, from the 
application server, the work of processing and backing up snapshots. When a backup 
operation uses a proxy client, it is known as a serverless backup. 

The data moves as follows:

1. The NetWorker server initiates the process by contacting the application server 
where the NetWorker VSS Client software is installed.

2. The application server with the NetWorker VSS Client software creates a 
snapshot of the data on the storage volume.

Note: In the figures, snapshots are represented by S1 through S5.

3. The snapshot is made visible to the proxy client.

4. The proxy client uses a snapshot in primary storage to transfer the data over the 
LAN and into traditional storage such as a file type disk, advanced file type disk, 
or tape.

Figure 2 LAN-based configuration with a proxy client
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LAN-free configuration
Figure 3 on page 13 shows a LAN-free configuration with a storage area network. The 
NetWorker VSS Client is installed on the application server. 

You can upgrade a NetWorker storage node version 7.3.2 to a NetWorker VSS Client 
storage node and use it as the proxy client to avoid the network traffic that is 
generated when a snapshot is rolled over to a conventional backup. Network traffic is 
avoided because the conventional backup device is directly attached to the storage 
node.

Note: “Setting up a proxy server for rapid backups of VSS snapshots” on page 27 provides 
information about setting up the NetWorker storage node as the proxy client.

The data moves as follows:

1. The NetWorker server initiates the process by contacting the application server 
where the NetWorker VSS Client software is installed.

2. The application server with the NetWorker VSS Client software creates a 
snapshot of the data on the storage volume.

Note: In the figures, snapshots are represented by S1 through S5. 

3. The snapshot is made visible to the proxy client.

4. The proxy client, in this case the storage node, uses a copy in primary storage to 
transfer the data into traditional storage such as a file type disk, advanced file 
type disk, or tape. 
EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, Installation Guide12
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The NetWorker server and the application server communicate through the LAN. 
However, the data itself is not transferred across the LAN because the traditional 
storage is attached directly to the NetWorker storage node.

Figure 3 LAN-free configuration

Installation roadmap
Use the following roadmap when installing the software on Microsoft Windows 2003.

◆ Review “Installation checklist” on page 13 and ensure that you have all the 
required installation media, pathnames, and license information.

◆ Review “Installation requirements” on page 14 and ensure that you have the 
required software before installing the NetWorker VSS Client.

◆ Review “Installation directories” on page 16 and ensure that you have the 
required directories before installing the NetWorker VSS Client.

◆ Install the client according to the instructions given in Chapter 2, ”Installing 
NetWorker VSS Client.”

◆ After the installation is complete, configure the software components according 
to the instructions in the Chapter 3, ”Enabling, Registering, and Authorizing the 
Software.”

Installation checklist
Review the following checklist to ensure that you have the required media and 
information for the installation.
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Introduction
Installation Media
The NetWorker VSS Client software is distributed in the following formats:

◆ On the NetWorker VSS Client CD, which is included in the EMC Information 
Protection Product Family Media Kit, that contains the software and online 
documentation.

◆ In the downloadable file of the evaluation software, available from the EMC 
website at http://Powerlink.EMC.com.

Pathname
The path of the NetWorker VSS Client binaries is required for the installation.

License information
The following license information is required after the installation:

◆ NetWorker VSS Client temporary evaluation enabler

◆ NetWorker base enabler

◆ NetWorker VSS Client license add-on enabler—The NetWorker VSS Client 
requires a specific license: Volume Shadowcopy Service for Windows. This license 
must be installed on the NetWorker server.

Chapter 3, ”Enabling, Registering, and Authorizing the Software,” provides more 
information on enablers and licensing.

Installation requirements
This section provides the installation requirements that must be met before installing 
the NetWorker VSS Client.

Hardware requirements
The following hardware requirements must be met before the installation.

◆ CPU: 2.0 GHz 

◆ Physical memory: 1 GB

◆ Host Architecture: 32-bit systems only 

Note: The current EMC Software Compatibility Guide provides more information on the 
supported hardware, software, and operating systems for the NetWorker VSS Client software.

Software requirements
Table 1 on page 15 lists the software requirements that must be met before the 
installation:
EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, Installation Guide14
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CAUTION

To avoid potential data loss, do not install or use the NetWorker VSS Client with 
other vendor’s VSS Requestor backup solutions. Data loss may occur if other VSS 
Requestor backup solutions delete shadowcopies created by the NetWorker VSS 
Client. Additionally, restoring an application using another vendor’s VSS 
Requestor backup solution may prevent the same application from being restored 
with the NetWorker VSS Client.

Table 1 Software requirements

Hardware Software requirements Version

NetWorker Server 
host

NetWorker Server software 7.3.2 Jumbo Patch Update 1, available from:
ftp://ftp.legato.com/pub/NetWorker/Updates/
732JumboUpdate1.

EMC CLARiiON® EMC CLARiiON FLARE® Operating 
Environment

FLARE version 19 or 22

NaviCLI The version that corresponds to the FLARE 
Operating Environment that is being used or higher.NaviAgent

Hotfixes for Storport drivers For Windows 2003 configurations running Storport 
drivers with CLARiiON storage arrays, the following 
hotfix from Microsoft is required. 
• WindowsServer2003-KB908980-v2-x86-ENU.exe

HBA drivers Driver: ql2300.sys 9.1.2.16 (w32)
(Consult EMC Support at 
http://Powerlink.EMC.com for HBA 
driver requirements.)

EMC Symmetrix® EMC Symmetrix Minimum Microcode Revision Version: 5670

Hotfixes for STORport drivers WindowsServer2003-KB903081-x86-ENU.exe
(Consult EMC Support at 
http://Powerlink.EMC.com for 
requirements for STORport.)

Solutions Enabler Required only if EMC CLARiiON or 
Symmetrix hardware is used.

VSSKIT Version 6.3.1
The EMC VSS Provider Version 3.0.1.0-4 is also 
installed with this version of Solutions Enabler.

Java run-time
Required for Solutions Enabler

Version 1.4.2.x

All Microsoft hotfixes for Replication 
Manager

SP1 and Microsoft hotfixes 
The list of Microsoft hotfixes for Replication Manager 
are as follow:
• WindowsServer2003-KB891957-x86-ENU.exe
• WindowsServer2003-KB898790-x86-enu.exe
• WindowsServer2003-KB912063-x86-ENU.exe
(Consult EMC Support at 
http://Powerlink.EMC.com for 
requirements for Replication Manager.)

Hotfix for any host running Microsoft 
Windows 2003/SP1 or Microsoft 
Windows 2003/R2 and connected to 
Symmetrix or CLARiiON storage.

KB916048 QFE
Installation requirements 15
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Installation directories
When the NetWorker VSS Client is installed, two directories are created. 

◆ The NetWorker and PowerSnapTM binaries are located in the 
%ProgramFiles%\Legato\nsr\bin directory.

◆ The Replication Manager binaries are located in the 
%ProgramFiles%\EMC\rmagentps\client\bin directory.

Table 2 on page 16 lists the installation services for NetWorker, PowerSnap, and 
Replication Manager:

Table 2 Services

Service names (in service 
control manager)

Service nicknames (use with the 
‘net start’ command) Process names

NetWorker Remote Exec Nsrexecd Nsrexecd.exe

NetWorker PowerSnap Service Nsrpsd Nsrpsd.exe

Replication Manager Client for 
RMAgentPS

Rmagentps Irccd.exe
RMServer.exe
EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, Installation Guide16
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This chapter provides the information you need to install the NetWorker VSS Client 
software successfully.

This chapter includes the following sections:

◆ Installing the software ................................................................................................... 18
◆ Installing NetWorker VSS Client in a MSCS environment ...................................... 19
◆ Verifying the installation ............................................................................................... 20
◆ Maintaining NetWorker Microsoft Windows VSS Client......................................... 20
◆ Removing NetWorker Windows VSS Client .............................................................. 24
◆ Removing previous installation of Solutions Enabler .............................................. 26
◆ Upgrading to NetWorker VSS Client storage node .................................................. 26
◆ Setting up a proxy server for rapid backups of VSS snapshots............................... 27

Installing NetWorker
VSS Client
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Installing the software

CAUTION

Remove any previous installation of NetWorker before installing NetWorker VSS 
Client. “Removing NetWorker Windows VSS Client” on page 24 provides 
information about how to remove a NetWorker VSS Client installation.

To install NetWorker VSS Client software on a Microsoft Windows computer, 
complete the following tasks:

◆ “Task 1: Access the installation files” on page 18

◆ “Task 2: Install the software” on page 18

Task 1: Access the installation files
Access the installation files from one of the following sources:

◆ “From a CD-ROM” on page 18

◆ “From the EMC website” on page 18

From a CD-ROM
To access the NetWorker VSS Client software from a local CD-ROM:

1. Log in as administrator or equivalent on the NetWorker server.

2. Insert the NetWorker VSS Client CD into the CD-ROM drive.

3. Run Setup.exe directly from the CD.

From the EMC website
To access the evaluation version of the NetWorker VSS Client software from the EMC 
Support website:

1. Go to http://softwareforms.EMC.com/resources/downloads/.

2. On the Evaluation Software Request page, select NetWorker Windows VSS 
Client from the products list and click Version 7.3 for the Windows platform.

3. Complete and submit the Evaluation Request Form with the contact information. 
An EMC Sales Representative will send you an email with a URL to the 
NetWorker VSS Client download file on the EMC FTP site.

Task 2: Install the software
Once you have accessed the NetWorker VSS Client software files, you are ready to 
begin the installation.

To install NetWorker VSS Client:

1. Run the Setup program (Setup.exe) to launch the installation wizard.

The Welcome to NetWorker User VSS Client Installation wizard appears.

2. Click Next.

The Customer Information dialog box appears.

3. Enter the name and organization information and click Next.
EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, Installation Guide18
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Installing NetWorker VSS Client
The License Agreement dialog box appears.

4. Read the license agreement. To accept, select the I accept the terms in the license 
agreement option, and click Next.

The Installation Location dialog box appears. 

5. To choose an alternate location for the installation folder, click Change and select 
a different installation location. Click Next.

The Change Folder dialog box appears. 

6. Specify the alternate folder location and name, and click OK.

The Replication Manager Client Setup dialog box appears.

7. For Control Port and Data Port, specify two different port number values that 
will be used by the Replication Manager Client service.

CAUTION

If you are using Replication Manager as a stand-alone product, then ensure 
that the Replication Manager port number values used for Control Port and 
Data Port are different from the port number values used for the stand-alone 
Replication Manager product. By doing this, you can use both the NetWorker 
VSS Client and Replication Manager on the same machine without conflict.

You may change the Replication Manager port settings after the installation is 
complete from the command line. “Changing Replication Manager port settings” 
on page 43 provides more information.

The Ready to Install dialog box appears.

8. Click Next to start the NetWorker VSS Client installation.

The installation may take several minutes.

If Exchange Server is installed on the same installation machine, the nwexinfo 
dialog box appears. In the nwexinfo dialog box, enter the Exchange Server 
domain information (Domain, Username, and Password) and click OK.

9. In the NetWorker User VSS Client Setup Complete window, click Finish to 
complete the installation and exit the installation wizard.

10. Enable and register the NetWorker VSS Client software according to instructions 
in Chapter 3, ”Enabling, Registering, and Authorizing the Software.”

11. Configure the setup according to instructions in Chapter 4, ”Configuration 
Tasks.”

Installing NetWorker VSS Client in a MSCS environment
When installing the NetWorker VSS Client in a Microsoft Cluster Server (MSCS) 
environment, ensure that first Microsoft Distributed Transaction Coordinator 
(MSDTC) is installed and running before installing the Solutions Enabler. The EMC 
Solutions Enabler, Version 6.3, Installation Guide provides details about installing and 
running Solutions Enabler.

Note: Install EMC Solutions Enabler only when using EMC VSS Provider.
Installing NetWorker VSS Client in a MSCS environment 19



Installing NetWorker VSS Client
To install the NetWorker VSS Client in a MSCS environment:

1. Install the NetWorker VSS Client software on the private disk of each physical 
node.

2. Configure each physical node as a Client resource on the NetWorker server.

3. In the Remote Access attribute of each virtual Client resource, type the names of 
the physical nodes.

4. Configure privileges for each physical node on the NetWorker server.

a. In the Users attribute of the Administrators user group, add the following 
values for each physical node in the cluster. Add each value on a separate line:

user=administrator,host=VSS_cluster_node

user=system,host=VSS_cluster_node

Where VSS_cluster_node is the DNS hostname of the physical node.

b. Click OK.

The EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, 
Administration Guide provides more information about configuring a clustered 
Client resource. 

For information about deploying Microsoft Exchange Server 2003 in a cluster, go to 
the Microsoft website.

Verifying the installation
Ensure that the following services are up and running.

◆ For NetWorker—nsrexecd.exe

◆ For PowerSnap—nsrpsd.exe

◆ For Replication Manager—irccd.exe

Maintaining NetWorker Microsoft Windows VSS Client
After installing the NetWorker VSS Client, you may run the Setup program in 
maintenance mode to change, repair, or remove the existing client installation.

How to run the Setup program in maintenance mode
To run the Setup program in maintenance mode:

1. Log in as administrator on the client server.

2. To run the Setup program in maintenance mode, do one of the following:

• Run the Setup.exe file.

• Go to Start > Settings > Control Panel > Add/Remove Programs. Select the 
NetWorker VSS Client and click Change.

The Welcome to NetWorker User VSS Client Maintenance dialog box appears.

3. Click Next.
EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, Installation Guide20



Installing NetWorker VSS Client
The Setup program detects the existing NetWorker VSS Client installation and 
displays the Maintenance Type dialog box, as shown in Figure 4 on page 21.

Figure 4 Maintenance Type dialog box

4. Select the type of maintenance to perform and click Next.

• Change—Use to change:

– The password for Exchange Server using nwexinfo.
– To a different authorized NetWorker server.
“How to change the installation type and authorized server” on page 21 
provides more information.

• Repair—Replaces corrupt files and adds missing files, shortcuts, registries, 
and services. “How to repair a software installation” on page 23 provides 
more information. 

• Remove—Removes the NetWorker VSS Client software from the system. 
“Removing NetWorker Windows VSS Client by running the Setup program in 
maintenance mode” on page 24 provides more information.

How to change the installation type and authorized server
To change the password for Exchange Server or change to a different authorized 
server:

1. Start the Setup program in the maintenance mode. “How to run the Setup 
program in maintenance mode” on page 20 provides more information. 

2. In the Maintenance Type dialog box, select Change and click Next.
Maintaining NetWorker Microsoft Windows VSS Client 21



Installing NetWorker VSS Client
The Ready to Change dialog box appears.

Figure 5 Ready to Change dialog box

3. Click Change to proceed.

The NetWorker Server Selection dialog box appears.

Figure 6 NetWorker Server Selection dialog box

4. In the NetWorker Server Selection dialog box, do any of the following:

a. Click Update List to browse for all the available servers, and click Add to add 
a server to the Available Servers list.

b. Select a server from the Available Servers list and click  to move the 
server to the Selected Servers list.

c. Select a server from the Selected Servers list and click  to move it back 
to the Available Servers list.

d. Type a server name in the Enter a server name field.
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Installing NetWorker VSS Client
CAUTION

If an authorized server list is used together with a proxy server, then the proxy 
server must also authorize the production server, and visa versa.

5. Click Next.

The selected NetWorker server is used to backup the data on the client. Incase you 
have not selected an alternate server, the default server is used to backup the data 
on the client.

The nwexinfo dialog box appears.

Figure 7 nwexinfo dialog box

6. Type the Domain, Username, and Password, and click OK.

The password for the Exchange Server is changed.

How to repair a software installation
To repair the NetWorker VSS Client software installation:

1. Start the Setup program in the maintenance mode. “How to run the Setup 
program in maintenance mode” on page 20 provides more information. 

2. In the Maintenance Type dialog box, select Repair and click Next.
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Installing NetWorker VSS Client
The Ready to Repair dialog box appears.

Figure 8 Ready to Repair dialog box

3. Click Repair to proceed.

The Setup repairs the NetWorker VSS Client. The process may take several 
minutes.

Note: You can repair the PowerSnap and Replication Manager binaries from Settings > 
Control Panel > Add/Remove Programs.

Removing NetWorker Windows VSS Client
Before installing NetWorker VSS Client, remove any previous version of the 
NetWorker client.

You may remove the NetWorker VSS Client by any of the following methods:

◆ Running the Setup program (Setup.exe) in the maintenance mode and selecting 
the Remove option. 

“Removing NetWorker Windows VSS Client by running the Setup program in 
maintenance mode” on page 24 provides more information.

◆ Using the Windows Add/Remove Programs option. 

“Removing NetWorker Windows VSS Client by using the Windows 
Add/Remove Programs option” on page 25 provides more information.

Removing NetWorker Windows VSS Client by running the Setup 
program in maintenance mode

This procedure removes the NetWorker VSS Client, PowerSnap, and Replication 
Manager installations.

To remove NetWorker VSS Client software, PowerSnap, and Replication Manager:

1. Start the Setup program in the maintenance mode. “How to run the Setup 
program in maintenance mode” on page 20 provides more information. 

2. In the Maintenance Type dialog box, select Remove and click Next.
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The Ready to Remove dialog box appears.

Figure 9 Ready to Remove dialog box

3. In the Ready to Remove dialog box, 

a. Select the Remove NetWorker User VSS Client Metadata option.

The Legato and rmagentps directories, and the Legato and RMService registry 
entries are removed.

Note: If you want to keep the existing data for reinstallation of the NetWorker VSS 
Client, then leave the Remove NetWorker User VSS Client Metadata option 
unchecked.

b. Click Remove.

Removing NetWorker Windows VSS Client by using the Windows Add/Remove Programs option
Use either of the following procedures to remove the NetWorker VSS Client:

◆ “How to remove only the NetWorker VSS Client software” on page 25

◆ “How to remove NetWorker VSS Client, PowerSnap, and Replication Manager 
software” on page 26

How to remove only the NetWorker VSS Client software
You may remove only the NetWorker VSS Client using Add/Remove Programs. After 
removing the NetWorker VSS Client using this procedure, you must explicitly 
remove PowerSnap and Replication Manager.

To remove only the NetWorker VSS Client:

1. Go to Start > Settings > Control Panel > Add/Remove Programs.

2. Select the NetWorker VSS Client and click Remove button. 

Note: Use this procedure to remove NetWorker VSS Client storage node installation. 

To remove PowerSnap and Replication Manager after removing the NetWorker VSS 
Client:

1. Go to Start > Settings > Control Panel >Add/Remove Programs.
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2. Select PowerSnap and click Change.

3. Click Remove, and then Next.

4. Click Remove.

Removing PowerSnap also removes Replication Manager. After removing 
PowerSnap, Add/Remove Programs continues to show that Replication Manager 
is installed. To confirm that Replication Manager is uninstalled, refresh the screen 
by pressing the F5 key. 

5. If Replication Manager is still uninstalled, go to Start > Settings > Control Panel 
> Add/Remove Programs, and remove RMAgentPS.

How to remove NetWorker VSS Client, PowerSnap, and Replication Manager software
To remove NetWorker VSS Client, PowerSnap, and Replication Manager software:

1. Go to Start > Settings > Control Panel > Add/Remove Programs.

2. Select the NetWorker VSS Client and click Change.

3. Click Remove, and then Next.

4. Click Remove.

First PowerSnap and Replication Manager software are removed, followed by the 
NetWorker software.

Note: Do not use this procedure to remove NetWorker VSS Client storage node installation 
because it does not remove the PowerSnap and Replication Manager binaries. 

Removing previous installation of Solutions Enabler
To uninstall Solutions Enabler:

1. Stop the Solutions Enabler services before uninstalling the Solutions Enabler by 
using the following command:

net stop storapid

2. Go to Start > Settings > Control Panel > Add/Remove Programs, and select EMC 
Solutions Enabler.

3. Click Remove.

Upgrading to NetWorker VSS Client storage node
To upgrade from NetWorker 7.3.2 storage node to NetWorker VSS Client storage 
node:

1. Ensure that you have installed NetWorker 7.3.2 storage node on the server. 

The EMC NetWorker, Release 7.3.2, Multiplatform Version, Installation Guide provides 
information about installing NetWorker 7.3.2 storage node.

For NetWorker VSS Client storage node installation, the NetWorkerEXT.XML file 
is located in the installation media and can be copied to other locations when 
setting up or configuring the NetWorker VSS Client storage node.

2. Install the NetWorker VSS Client. “Installing the software” on page 18 provides 
more information.
EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, Installation Guide26



Installing NetWorker VSS Client
When the NetWorker VSS Client installation detects that a NetWorker 7.3.2 
storage node is already installed on the server, a dialog window appears.

3. Click OK to upgrade to NetWorker VSS Client storage node.

The NetWorker VSS Client storage node is installed.

Although the PowerSnap and Replication Manager binaries are installed on the 
existing storage node during the upgrade procedure, the NetWorker VSS Client 
storage node can not be used as the NetWorker VSS Client.

Setting up a proxy server for rapid backups of VSS snapshots
To be able to take rapid backups of VSS Snapshots created by NetWorker VSS Client, 
you can set up the NetWorker VSS Client or the NetWorker VSS Client storage node 
to act as the proxy client. The NetWorker VSS Client storage node acts as the proxy 
client in a SAN-based storage node configuration. 

The EMC NetWorker VSS Client for Microsoft Windows Server 2003, First Edition, 
Administration Guide provides more information.
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This chapter explains how to enable the NetWorker VSS Client software and features 
for permanent use. When the NetWorker VSS Client software is installed, it is in a 
temporary evaluation mode with all of the features available. For specific licensing 
questions, go to http://Powerlink.EMC.com.

This chapter includes the following sections:

◆ How NetWorker VSS Client software is licensed...................................................... 30
◆ The evaluation process .................................................................................................. 30
◆ The licensing process ..................................................................................................... 31
◆ Update enablers.............................................................................................................. 34
◆ Managing EMC licenses................................................................................................ 35
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How NetWorker VSS Client software is licensed
The NetWorker VSS Client software is installed in evaluation mode. The licensing of 
NetWorker software means entry of enabler and authorization codes on the server for 
the NetWorker environment. Without these codes, the software or added features will 
not run beyond the evaluation period.

Each installation of NetWorker VSS Client must be licensed with a base enabler that 
turns-on the software and allows you to use the software. All licensing takes place on 
the server. The licenses are entered and stored on the server, and the server enforces 
the licensing. 

Base enablers come in different editions, which enable varying degrees of 
functionality. Add-on enablers allow a broader scope of features. The specific add-on 
enabler for NetWorker VSS Client is Volume Shadowcopy Service for Windows.

The steps in this chapter assume that all of the software and hardware requirements 
have been met and the NetWorker VSS Client software is installed. 

The evaluation process
Evaluating NetWorker VSS Client software can take place in two ways:

◆ By evaluating a new installation of the software on a Windows server 

◆ By evaluating NetWorker features on an existing NetWorker installation

Evaluating a new installation
When you first install the NetWorker VSS Client software, you can evaluate it with all 
the modules and features for 30 days free without entering any codes.

By the end of the evaluation period, you must purchase, enter, and authorize a base 
enabler to continue to use the NetWorker VSS Client software to restore data. The 
base enabler is the license that enables the edition purchased. 

To continue to use the modules and features that were available with the evaluation 
software, you might need to purchase the NetWorker VSS Client add-on enabler, 
depending on the edition of the base enabler.

Evaluating features on an existing installation
If you are evaluating one or more NetWorker VSS Client modules or features on an 
edition of the software that has already been installed and enabled, you must enter a 
temporary enabler for each module or feature. The temporary enabler is valid for 45 
days. 

Contents documentation in the EMC Information Protection Media Kit, and “Where to 
get help” on page 7 provide information about how to obtain a temporary enabler 
code.

“How to enter a temporary enabler code” on page 31 provides information about 
how to enter the temporary enabler code. By the end of the evaluation period, you 
must purchase, enter, and authorize the corresponding license enablers to continue to 
use modules or features evaluated by you. “The licensing process” on page 31 
provides instructions. 
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How to enter a temporary enabler code

CAUTION

The temporary enabler code is valid on only one computer in a network. If you 
enter the same code on more than one computer in a network, a copy protection 
violation error occurs and the NetWorker VSS Client software is disabled on all 
NetWorker servers with duplicate enablers.

To enter the temporary enabler code:

1. Start the NetWorker Management Console software.

2. Launch the Administration window:

a. From the Console window, click Enterprise.

b. From the left pane, select a NetWorker server in the Enterprise list.

c. From the right pane, select the application.

d. From the Enterprise menu, click Launch Application. 

The Administration window is launched as a separate application.

3. From the Administration window, click Configuration.

4. In the left pane, select Registration.

5. From the File menu, select New.

6. In the Enabler Code attribute, type the enabler code.

7. In the Name attribute, type the name of the license.

8. (Optional) In the Comment attribute, type a description of the license.

9. Click OK.

The licensing process
To permanently use NetWorker VSS Client software, you must purchase and enter a 
license enabler code, and then authorize it. This licensing process is the same for all 
editions of software as well as for individual modules and features. 

The license enabler code that you purchase is valid for 45 days, as a registration 
period. During the registration period, you must obtain and enter a corresponding 
authorization code. 

The following sections explain how to enter and authorize the license enabler:

◆ “Task 1: Enter the license enabler code” on page 31

◆ “Task 2: Obtain an authorization code” on page 32

◆ “Task 3: Enter the authorization code” on page 33

Task 1: Enter the license enabler code
License enabler codes are included in either the letter announcing the updated or 
upgraded software, or on the Enabler Certificate you receive when you purchase a 
software license. This depends on whether the software purchased is a first-time 
purchase or an updated or upgraded version.
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Note: To save time when entering multiple licenses, enter the base enabler last. Otherwise, once 
a base enabler is entered, devices that do not yet have licenses entered may be disabled. Those 
devices would have to be reenabled manually after their licenses are installed.

To enter the license enabler code:

1. Start the NetWorker Management Console software.

2. Launch the Administration window:

a. From the Console window, click Enterprise.

b. From the left pane, click a NetWorker server in the Enterprise list.

c. From the right pane, click the application.

d. From the Enterprise menu, select Launch Application. The Administration 
window is launched as a separate application.

3. In the Administration window, click Configuration.

4. In the left pane, select Registrations.

5. From the File menu, select New. 

The Create Registration dialog box appears.

6. In the Enabler Code attribute, type the enabler code.

7. In the Name attribute, type the name of the license.

8. (Optional) In the Comment attribute, type a description of the license.

9. Click OK.

The new license is added and appears in the right pane. Repeat the procedure to 
add any additional enabler codes. After you enter a license enabler code, you 
have 45 days as a registration period to authorize the NetWorker VSS Client 
software.

Task 2: Obtain an authorization code
Registration of NetWorker VSS Client software takes place by obtaining an 
authorization code. Obtain a unique authorization code through one of the following 
methods:

◆ “Using the EMC website” on page 32

◆ “Using email” on page 33

CAUTION

If the software or feature is not authorized by the end of the 45-day registration 
period, the NetWorker VSS Client function or feature is disabled. 

Using the EMC website
Register products and obtain authorization codes online by completing a registration 
form on the EMC website at http://Powerlink.EMC.com. Web registration takes just 
a few minutes and is available 24 hours a day, 7 days a week.

An authorization code that permanently enables the NetWorker license is sent by 
email. 
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Using email
To register the software and obtain an authorization code by email:

1. Start the NetWorker Management Console software.

2. Launch the Administration window:

a. From the Console window, click Enterprise.

b. From the left pane, select a NetWorker server in the Enterprise list.

c. From the right pane, click the application.

d. From the Enterprise menu, select Launch Application. The Administration 
window is launched as a separate application.

3. In the Administration window, click Configuration.

4. In the left pane, select the NetWorker server.

5. From the File menu, select Properties.

The Properties dialog box appears.

6. Select the Customer Information tab and complete your contact information.

7. Email your registration information. For contact information, go to the EMC 
CustomerNet portal at http://Powerlink.EMC.com.

An authorization code that permanently enables the updated NetWorker 
software is sent to you.

Task 3: Enter the authorization code
To complete the licensing process, you must enter the unique authorization code on 
the NetWorker server within 45 days of entering the license enabler code.

If the authorization process is successful, the expiration date for the license displays 
"Authorized - No expiration date." If the authorization is not verified in this way, 
contact http://Powerlink.EMC.com.

To avoid an interruption in restores, if you move the NetWorker VSS Client software 
from one computer to another, or to change the network address of a computer after 
the software is installed, perform one of the following:

◆ Obtain a new authorization code. You need the host ID of the original server as 
well as the new server. The host ID appears in the server’s Registration window. 

◆ Install and configure the License Manager software. For more information on 
using the License Manager, refer to “Managing EMC licenses” on page 35 and the 
latest EMC NetWorker License Manager Installation Guide.

How to enter the authorization code
To enter the authorization code:

1. Start the NetWorker Management Console software.

2. Launch the Administration window:

a. From the Console window, click Enterprise.

b. From the left pane, select a NetWorker server in the Enterprise list.

c. From the right pane, click the application.

d. From the Enterprise menu, select Launch Application. 
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The Administration window is launched as a separate application.

3. In the Administration window, click Configuration.

4. In the left pane, select Registration. 

5. In the right pane, select a license.

6. From the file menu, select Properties.

7. In the Auth Code attribute, type the authorization code for the product (the 
authorization code assigned to the specified permanent enabler or update enabler 
code).

8. Click OK.

The license is now permanently enabled.

Update enablers 
To update existing NetWorker VSS Client software to a major release (one that 
introduces important new features), an update enabler is necessary. Update enablers 
are required for any major NetWorker software update, including the current 
NetWorker release. To use the License Manager, the NetWorker server must be 
release 5.0 or later.

With a first-time purchase of NetWorker VSS Client software, a one-year update 
agreement might be included. After one year, an update enabler may be acquired 
with a new update agreement purchase.

Additional licenses
This section describes a few of the additional licenses required to operate some of the 
NetWorker features. 

Client connection licenses
Every computer to be restored in a NetWorker datazone requires a client connection 
license, even the NetWorker server. The client connection license may be one of the 
licenses supplied with the base enabler or purchased separately. A cluster client or 
NDMP data server requires a special type of client connection license, as described in 
“Cluster clients” on page 34 or “Managing EMC licenses” on page 35.

NetWorker application modules
NetWorker application modules are licensed on the basis of one enabler per database 
type host. For example, to back up the Exchange database on two hosts, two 
NetWorker module for Exchange enablers are required, even if the two hosts are 
backed up by the same server.

However, if multiple database instances are running on a NetWorker client host, only 
one NetWorker module enabler is required for that one host.

Cluster clients
For each physical node in a cluster, you must purchase a Cluster Client Connection, 
which takes the place of one standard client connection. The EMC NetWorker, Release 
7.3.2, Multiplatform Version, Administration Guide provides more information on 
licensing computers in a cluster.
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Managing EMC licenses
The License Manager provides centralized license management, allowing you to 
maintain all of an enterprise’s NetWorker licenses from a single computer. With the 
License Manager, you can move NetWorker VSS Client software from one computer 
to another, or change the IP address on an existing NetWorker server without having 
to reauthorize the software. The License Manager can be installed as an option during 
NetWorker VSS Client software installation.

To begin to implement the License Manager:

1. Contact Licensing to obtain bulk enabler codes. Go to 
http://Powerlink.EMC.com for more information. 

2. Install the License Manager software. 

3. Configure the License Manager software. 

4. Configure the NetWorker servers to access the License Manager for their licenses. 

The EMC NetWorker License Manager Installation Guide provides details on 
installing and using the License Manager.
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This chapter provides information on how to configure and use the NetWorker VSS 
Client after installing the software.

This chapter includes the following sections:

◆ Using Windows 2003 SP1 Security Configuration Wizard ...................................... 38
◆ Configurations specific to PowerSnap........................................................................ 39
◆ Configurations specific to CLARiiON ........................................................................ 39
◆ Configurations specific to Symmetrix......................................................................... 41
◆ Updating the NetWorker VSS Client with Exchange username, 

password, or domain ..................................................................................................... 43
◆ Changing Replication Manager port settings ............................................................ 43

Configuration Tasks
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Using Windows 2003 SP1 Security Configuration Wizard
This section describes how to set up security on a Microsoft Windows Server 2003 
(Service Pack 1) platform that is running NetWorker VSS Client software.

Before configuring the NetWorker VSS Client, install the Security Configuration 
Wizard (SCW). The wizard is included with Microsoft Windows Server 2003 (Service 
Pack 1), but is not installed by default. For information about the wizard installation, 
select the Security Configuration Wizard shortcut that appears on the Microsoft 
Windows 2003 desktop after the Service Pack 1 is installed. 

After installing the wizard, use it to select the appropriate security parameters and 
ensure that the firewall settings do not impact NetWorker processes.

By default, the Microsoft Windows firewall is disabled. If the Microsoft Windows 
firewall is enabled, you must also enable exceptions so that the NetWorker processes 
are able to send information through the firewall.

The NetWorker VSS Client software fails:

◆ If during the installation of Service Pack 1, you skip the Network Security step 
and select the defaults. 

The Microsoft Windows firewall configuration prevents the NetWorker software 
from functioning correctly. 

◆ If you increase the network security by using the SCW. 

The Microsoft Windows firewall prevents NetWorker processes from passing 
information through the firewall.

To configure the NetWorker system to function properly on a Microsoft Windows 
Server 2003 (Service Pack 1) platform, use one of the following procedures:

◆ “How to extend the Security Configuration wizard” on page 38

◆ “How to manually configure exceptions for the Windows firewall” on page 38

How to extend the Security Configuration wizard
To extend the Security Configuration wizard: 

1. Copy %ProgramFiles%\Legato\nsr\bin\NetWorkerEXT.XML to the 
%SystemDrive%\WINDOWS\security\msscw\kbs directory. 

2. Run the following command from the 
%SystemDrive%\WINDOWS\security\msscw\kbs directory: 

scwcmd register /kbname:NetWorker /kbfile:NetWorkerEXT.XML

3. Run the Security Configuration Wizard. 

How to manually configure exceptions for the Windows firewall
To manually configure exceptions for the Windows firewall:

1. From the Windows Start menu, click Control Panel, and select Windows 
Firewall. 

2. Select the Extensions tab and click Add Program. 

3. Click Browse, then navigate to the directory that contains the NetWorker 
software. 
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The default installation directory for the NetWorker software is 
%ProgramFiles%\Legato\nsr\bin.

4. For each NetWorker Client Binary executable file, click Open, and then click Add. 

• nsrexecd.exe 

• nsrexec.exe 

• nsrpsd.exe

• nsrsnapagent.exe

• nsrbragent.exe

• nsrbwragent.exe

• irccd.exe

• nsrsnap_vss_save.exe

• nsrsnap_vss_recover.exe

5. Restart the NetWorker VSS Client software. 

Configurations specific to PowerSnap
If you do not have administrative rights and are running programs, add the 
username for the account that is logged into the server.

1. Set the PowerSnap NetWorker security using either:

• nwadmin (User Groups)

• or

• NMC (from Configuration > User Groups)

2. Add the following values to the Administrators User Group for the production 
host and proxy host:

user=Administrator,host=<fqdn>

For example:

• For production host:

user=system,host=bv-clsrv.belred.emc.com 

• For proxy host:

user=system,host=qe2.belred.emc.com

Configurations specific to CLARiiON
To configure CLARiiON storage arrays, refer to your CLARiiON documentation. 
Additionally, ensure that the following configuration tasks are performed:

◆ “Task 1: Update the CLARiiON configuration file” on page 40

◆ “Task 2: Update the SYMCFG authorization list” on page 40

◆ “Task 3: Update the Navisphere Privileged Users list” on page 41
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Task 1: Update the CLARiiON configuration file
To support Replication Manager, edit the CLARiiON configuration file (clarcnfg) 
with the CLARiiON array name and the IP addresses or DNS host names of the two 
storage processors that exist in each CLARiiON machine.

The clarcnfg file is located in the 
%ProgramFiles%\EMC\SYMAPI\config\clarcnfg directory.

Use the following sample configuration file template as a guide when adding values 
to your CLARiiON configuration file. Obtain the values from the CLARiiON array 
configuration. 

###########################################################
# CLARiiON CONFIGURATION FILE TEMPLATE
# This CLARiiON configuration file provides network addresses
# (hostnames or IP addresses) for the two Storage Processors on 
# each CLARiiON which can be seen by this host.  To load 
# information about CLARiiON systems, CLARAPI must be able to
# communicate with the Navisphere Agent that administers them.
# CLARAPI Discovery depends on valid entries in this file. 
#
# CLARiiON Arrayname Storage Processor A  Storage Processor B
# XXXXXXXXXXXX losat246 losat247

 APM00052211461    10.5.221.132      10.5.221.133

Task 2: Update the SYMCFG authorization list
The SYMCFG authorization list must be updated to support the EMC VSS Provider. 
Use the following example to update the SYMCFG authorization list for your 
configuration. In the following example, the two host name IP addresses identify the 
two storage processors that exist on each CLARiiON machine.

1. Update the SYMCFG authorization list with the host name IP address, user name, 
and password for storage processor A. For example:

%ProgramFiles%\EMC\SYMCLI\bin>symcfg authorization add -host 
10.5.221.132 -username gadmin -password rdc4xyz

2. Update the SYMCFG authorization list with the host name IP address, user name, 
and password for storage processor B. For example:

%ProgramFiles%\EMC\SYMCLI\bin>symcfg authorization add -host 
10.5.221.133 -username gadmin -password rdc4xyz

3. Verify that the SYMCFG authorization list has been updated correctly. For 
example:

%ProgramFiles%\EMC\SYMCLI\bin>symcfg authorization list

Host name      Username
-------------------   --------------------
10.5.221.132          gadmin

10.5.221.133          gadmin
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Task 3: Update the Navisphere Privileged Users list
EMC Navisphere® is software that enables one to manage CLARiiON storage 
systems. To create a secure environment, update the EMC Navisphere Privileged 
Users list with the DNS host name or IP address of the CLARiiON Storage Processors 
(SPA and SPB). 

Enter values in the Privileged Users list in the following format:

system@hostname_SPA

system@hostname_SPB

where hostname_SPA and hostname_SPB are the DNS host names or IP addresses 
of the CLARiiON storage processors.

The EMC Navisphere Manager Administrator’s Guide provides more information about 
adding entries to the Privileged Users list.

Configurations specific to Symmetrix
This section contains instructions for setting up the device group and establishing 
mirrors with BCVs on Symmetrix.

For all other options, use the -help option with any SYMCLI or refer to the EMC 
Solutions Enabler Symmetrix CLI, Version 6.3, Quick Reference or EMC Solutions Enabler 
Symmetrix TimeFinder Family CLI, Version 6.3, Product Guide.

To create a device group and attach the STD and BCV devices:

1. To create device group, type the following command:

symdg create <device group name>

For example:

symdg create nw_group

2. To add a STD device to the device group, use the following command:

symld -g <device group name> -sid <Symm id> add dev <symm device 
name>

For example:

symld -g nw_group -sid 197 add dev 019

3. To add a BCV to the device group, use the following command:

symbcv -g <device group name> -sid <Symm id> add dev <symm device 
name>

For example:

symbcv -g nw_group -sid 197 add dev 0C0

4. Check the device group:

symld -g <device group name> list

For example:

symld -g nw_group list

This command examines information about the new device group created inside 
the SYMAPI database (sympai_db_bin) which resides on the host.
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5. To query the mirror status on device group, use the following command:

symmir -g <device group name>

For example:

symmir -g nw_group

This displays the mirror relationship, though it is shown as Split because no 
mirror is established between the STD and BCV devices. 

Note: The logical device name for the STD device from the output, for example, DEV001.

6. Attach the STD and BCV device using the following command:

symmir -g <device group name> attach <STD logical device name> BCV dev 
<symm device name>

For example:

symmir nw_group attach DEV001 BCV dev 0C0

7. To display the attachment status and current pairing relationship, use the 
following command:

symmir -g <device group name> -attach query

For example:

symmir -g nw_group -attach query

8. Establish the mirror between STD device and BCV device using the following 
command:

symmir -g <device group name> -full -noprompt -v establish

For example:

symmir -g nw_group -full -noprompt -v establish

9. To query the status and attach info, use the following command:

symmir -g <device group name> query

symmir -g <device group name> -attach query

For example:

symmir -g nw_group query

symmir -g nw_group -attach query

This should show SyncInProg or Synchronized state.

10. To detach the relationship use the following command:

symmir -g <device group name> detach <STD Logical name> BCV dev 
<symm device name>

For example:

symmir -g nw_group detach DEV001 BCV dev 0C0

11. To add more BCVs to any STD device, use the following command:

symmir -g <device group name> -full establish <STD logical device name> 
bcv ld <BCV logical device name> -noprompt

For example:
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symmir -g nw_group -full establish DEV002 bcv ld BCV004 
-noprompt

12. To check the status of all mirrors, use the following command:

symmir -g <device group name> query -multi

For example:

symmir -g nw_group query -multi

Updating the NetWorker VSS Client with Exchange username, 
password, or domain

When the NetWorker VSS Client is installed on an Exchange server, the nwexinfo.exe 
utility runs as part of the NetWorker VSS Client installation. This utility updates the 
NetWorker VSS Client with the Exchange username, password, and domain. 

Run the nwexinfo.exe utility again if:

◆ The Exchange server is installed after the NetWorker VSS Client is installed.

◆ The username, password, or domain changes after the NetWorker VSS Client is 
installed.

To run the nwexinfo.exe utility, double-click the nwexinfo.exe file from the 
%ProgramFiles%\Legato\nsr\bin directory.

Changing Replication Manager port settings
The Replication Manager port settings are specified during the NetWorker VSS Client 
installation. However, you can use the following procedure to change the Replication 
Manager port settings after the NetWorker VSS Client is installed.

To change the Replication Manager port settings:

1. From the command line, stop the rmagentps service. 

For example:

net stop rmagentps

2. From the %ProgramFiles%\EMC\
rmagentps\client\bin directory, run the irccd command to change the port 
settings. 

For example:

irccd –p <control_channel_port> -P <data_channel_port>

3. Start the rmagentps service. 

For example:

net start rmagentps
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